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TalkMaster

Welcome

Welcome to TalkMaster™! i3 Ethernet Intercoms and TalkMaster™ are Digital Acoustics
Corporation products.

If you are upgrading from an earlier version of TalkMaster™, please review the Release Notes.
To setup and configure your ii3 series intercoms, please review Configure Intercoms.

If you would like Help on using TalkMaster™, please review TalkMaster Main Screen
functions.

TalkMaster™ LE

Release Notes

TalkMaster™ 1.5 contains the following enhancements:

Simplified screen

Password protected Intercom search and configure

Console forwarding and retrieval
Enhanced Audio Archive functions

The Door Open function appears on the main screen

Keyboard control of the Talk and Listen buttons

New firmware is available for the ii3 IP Intercoms. Units must be flashed with new firmware in
order to accommodate the following features. Please refer to Configure Intercoms for details:

e Location names flashed into the Intercom

Audio sent to multiple intercoms is sent as a single a UDP broadcast

Console forwarding and retrieval

Specify alternative IP addresses for intercom forwarding in the event of TalkMaster™
console failure

Specify duration of time for activation of door/open relay within the ii3 IP Intercom

System Requirements
To utilize all of the features of TalkMaster, you need the following:
o Windows 98SE, Windows 2000, or Windows XP

e Pentium Ill 750mHz or faster
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e 128 MB RAM (256 MB suggested)
e 50 MB Available Disk Space

¢ Windows supported Sound Card with microphone and speakers
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TalkMaster Overview

TalkMaster™ is designed to work with Digital Acoustics’ ii3 Intercoms. TalkMaster™ has two
main functions. First, TalkMaster™ must be used to configure the IP address information and
related features for your ii3 intercoms.

Secondly, it allows multiple intercoms to connect to the software so they can be monitored by
the TalkMaster™ console operator. The audio from an intercom can be heard on the PC’s
speakers and the PC’s microphone is used to send audio to an intercom. Calls can be initiated
from any intercom to TalkMaster™ or vice versa.

B TalkMaster LE

File “iew Tools Conscle Help

By TalkMaster™ LE

Lacation Status Addiess [oor/Gate Motes

Calls Waiting [ Detais [ Time Auto Response Talk Mode
™ Unattended © Selected
) . Q Group
Audio Archive O Al Active
[v Capture
Flay File
Listen mode
System Events O Automatic Chirne:
ready . 0 intercoms online @ Manual

Talk

»

<

192.168.264.112 Speaker on Mic aoff

TalkMaster main screen

* |ntercom Cenfiguration Tool
File Wiew Action Help

Selected Intercom Setting
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G oor 1 117 Client DHCP
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TalkMaster configuration screen
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TalkMaster Main Screen

Before you begin using your Digital Acoustics ii3 Intercoms, they must be
configured with IP address information. Please see Configure Intercoms.

The following sections describe the areas of the TalkMaster™ main screen.

Tool Bar

Forward Intercoms to an alternate TalkMaster Console. Please see Forward Intercoms
for details.
=i

E l Retrieve Intercoms from an alternate TalkMaster Console. Please see Retrieve
Intercoms for details.

Active Intercom List

This list will show all of the intercoms that have connected to the TalkMaster™ server during
this session. Clicking on an intercom allows you to communicate with it by clicking the Talk or
Listen buttons. Right clicking on an open area in the list will de-select the active intercom.

Gip Location Statuzs Address Door/Gate Motes
@ [ | Front Doar Caonnected 192.168.254.114
@ | [ |Back Door Connected 192168254116 | @ Open

e The first column indicates if the intercom is connected or not.

e The Grp column allows you to create a group of intercoms to send audio to by checking this
box

e The Location column identifies the Intercom by Name

e The Status column displays the Intercoms status

¢ The Address column contains the Intercoms IP address

e The Door/Gate column indicates whether the Intercom has a Door Relay option configured.
Clicking the green circle will turn on the Door Relay for the amount of time that has been
configured in the intercom. For Intercoms that do not have the latest firmware, the Door

Relay will turn on for 5 seconds

¢ The Notes column displays information about intercom communications

You can right click on an Intercom to display detailed information about the intercom.
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Send announcement to selected units
Activity and Connection Details *

Feset connection
Intercam ID# 1036E9
25 version: ¥1.9.5.66.8-0.0-3.63.4

Calls Waiting

This list shows calls that have come in while another call was in progress. A call is considered
"in progress" when either the Talk or Listen button is active.

Calls ‘Waiting | Detais [ Time
Front Dioor message in at 0757 Ak o3

e If you single click on the entry, the intercom becomes the current selection in the Active
Intercom List allowing you to communicate with it

o If you double-click on it, the Audio Player pops up so you can play back the original call

Audio message player - iz [¥]
Meszages fram 01:11 P, Aug 3
Intercom: Front Door

Jﬂﬂﬂ 00: 00:02

¢ Once you play the audio clip, the "Delete played files on exit is automatically checked and
clicking the X in the right hand corner closes the Audio Player and deletes the clip

o If you choose to leave the Audio Player open, you can delete a call by right clicking on it and
selecting the Delete option

Auto Response

The Auto Response function allows you to temporarily suspend the console’s operation. This
function can also be activated by using the menu Console - Unattended Console.

Auto Responze
[ Unattended

Once you check the Unattended box, a dialog pops up reminding you that this mode has been
set.
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Console Currently Unattended

IIhattended Mode iz Enabled

Presz "Cancel' to return Console to normal
operation status.

Any intercom that tries to contact the console is notified that no one is available to take their
call. Please see Unattended Console for more information.

Clicking the Cancel button returns the console to normal operation.
This setting is saved between TalkMaster™ sessions.

Audio Archive

Checking the Capture box allows you to archive speaker and microphone audio for playback
at a later time. This function can also be activated by using the menu option File > Capture
Audio Archive. Please refer to Capture Audio Archive for more information.

Audio Archive
v Capture

To play back archived audio, use the menu option File > Play Archive Audio.
Un-checking the Capture box turns off the archiving feature.
This setting is saved between TalkMaster™ sessions.

Listen Mode

The Listen Mode determines how the Talk and Listen buttons function in TalkMaster™ and
how the PTT (Push to Talk) button works on the Intercom.

Ligten mode
& Automatic
O Manual

When set to Automatic, the PTT button on the intercom can be controlled by the TalkMaster™
Software allowing the intercom to operate in near "hands free" mode.

When set to Manual, the PTT button on the can be controlled by the TalkMaster™ software or
by the intercom.

For more information, see Listen Mode
This setting is saved between TalkMaster™ sessions.

Talk Mode
The Talk Mode setting determines which intercoms you will be communicating with.
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Talk tode
(& Selected
O Group
O all Active

Flay File

Chimne

Selected - refers to the intercom currently highlighted in blue in the Active Intercom List
Group - refers to any intercom that has an X in the Grp column of the Active Intercom List.
All Active - refers to all intercoms in the Active Intercom List.

For more information, see Talk Mode.

This setting is saved between TalkMaster™ Sessions.

Switching from Selected to either Group or All Active will automatically change the Listen
Mode to Manual.

Listen button

The Listen button either turns on or is turned on by the PTT button on an Intercom selected in
the Active Intercom List. You may only listen to a single intercom at one time.

The state of the Listen button can be toggled by:
¢ Single clicking the button with the mouse or

¢ Pressing the escape key

Talk button

The Talk button turns on the PC’s microphone and allows you to speak to the selected
intercom(s) selected in the Active Intercom List.

By default, the state of the Talk button can be toggled by:
¢ Single clicking the button with the mouse or

¢ Pressing the space bar

Please see Preferences for an alternate way to control the Talk button.

System Events

The System Events window tracks activities from TalkMaster™. Information is this window
can be used by Digital Acoustics Technical Support for diagnosing support issues.
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System Events
ready . 2 intercoms onling. Ma callz waiting

Listen Mode

Listen mode determines how the Listen and Talk buttons in TalkMaster™ and the Intercom
PTT button will be used. In Automatic mode the buttons will work in a predefined method. In
Manual mode, the TalkMaster™ operator can decide how the buttons will be used.

Automatic Mode assumes that the Intercom user will be operating in an almost "Hands Free"
environment. If the Intercom user initiates a call to TalkMaster™, they will have to press and
hold the PTT Button to start the conversation. When the Intercom user releases the PTT
button, the TalkMaster™ operator will take control of the buttons and the Intercom operator will
be able to participate Hands Free.

Please note that the following example uses the default action of single clicking the mouse or
tapping the space bar to activate the Talk button. Please see Preferences for an alternate
method of controlling the Talk button

Example:
Intercom user presses and holds the PTT button on one of the Intercoms and begins speaking.

The Intercom will be automatically selected in TalkMaster™ and the audio will be played
through the PC speakers.

The Intercom user releases the PTT button when done speaking

The TalkMaster™ operator responds by, clicking the Talk button or tapping the space bar on
the keyboard and begins speaking into the microphone.

When done speaking, the TalkMaster™ operator clicks the Talk button or taps the space bar.
This action turns off the Talk button and turn on the Listen button. This automatically
activates the PTT button on the Intercom and allows the Intercom user to operate "Hands
Free"

Each time the TalkMaster™ operator clicks the Talk button or taps the space bar, the Talk and
Listen buttons are toggled.

To end the conversation with an Intercom, the TalkMaster™ operator clicks the Listen button
or presses the Escape key on the keyboard while the Listen button is active.

An important benefit of using Automatic mode is that any other intercom is
prevented from interrupting your "conversation" because the Talk or Listen
button is always active. TalkMaster™ will not interrupt a call if there is already
one in progress. Any other infercom that tries to contact TalkMaster™ will be
placed in the Calls Waiting list.

In Manual Mode, the TalkMaster™ operator decides if the intercom user will operate in an
almost "Hands Free" environment or in a traditional PTT environment. If the Intercom operator
initiates a call to TalkMaster™, they will have to press and hold the PTT Button to start the
conversation. When the Intercom user releases the PTT button, the TalkMaster™ operator
can decide whether the Intercom user will be need to use the PTT button any more.
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Please note that the following example uses the default action of single clicking the mouse or
tapping the space bar to activate the Talk button. Please see Preferences for an alternate
method of controlling the Talk button

Example:
Intercom user presses and holds the PTT button on one of the Intercoms and begins speaking.

The Intercom will be automatically selected in TalkMaster™ and the audio will be played
through the PC speakers.

The Intercom user releases the PTT button when done speaking

The TalkMaster™ operator responds by, clicking the Talk button or tapping the space bar on
the keyboard and begins speaking into the microphone.

When done speaking, the TalkMaster™ operator clicks the Talk button or taps the space bar.
This action turns off the PC’s microphone.

The TalkMaster™ operator can then click the Listen button or press the escape key to turn on
listen mode or can allow the Intercom user to use the PTT button to respond.

In Manual mode, it is possible for another intercom to interrupt your conversation by pressing
the PTT button when neither the Talk or Listen button is active.

Talk Mode

Talk Mode determines which intercom(s) will hear audio sent from TalkMaster™.

Talk Mode
& Selected
O Group
) Al dctive

Flay File

Chirme

When using Selected mode, audio is sent to the intercom using a single TCP/IP stream. This
allows you to communicate with an Intercom located anywhere that you can connect to
through TCP/IP.

When using Group or All Active modes, audio is sent to the intercoms using a single UDP
Broadcast stream. Since UDP Broadcasts are filtered by many routers, the Group and All
Active options may only work on the current segment of a Local Area Network.

Pressing the Talk, Chime, or Play File button will send audio to the intercom(s) you have
indicated.

Play File - Allows you to select a pre-recorded .wav file to be played on the intercom(s).

Chime - plays the page.wav file from the iSupport subdirectory located under the
TalkMaster™-ii3 program directory. Page.wav is a recording of four successive beeps. If you
wish, you can re-record page.wav with an audio clip of your choosing.
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Talk will turn on the PC’s microphone to send the audio out. By default, single clicking the
Talk button or tapping the space bar activates Talk button. Please see Preferences for an
alternate method of activating the Talk button.

To play a .wav file on the Intercom(s), audio files must be encoded in either
8khz 8 bit PCM or 16 bit uLaw format. Commercial or free software is
available to create these formats.

Preferences

Preferences are used to specify various settings for TalkMaster™. This can be accessed from
the menu option View 2> Preferences.

The Options tab sets options that affect the behavior of all intercoms.

'™ Preferences

Options l Settings l Advanced l

Application Options &
Fing Interval Startup Audio

* Beep
20 zecaond:
l_ " Speech

v Generate local page on remote intercom *'+" kevpress
v Usze beep tones at start and end of incoming calls

[ Hide when minimized

[ Talk button enabled by mouse click and hald

Help

Ping Interval - sets how often TalkMaster™ will send a Ping command to the intercoms to
verify the connection

Startup Audio - Determines if a beep or a wav file is played when the Intercom connects to
TalkMaster™. If you select Speech, you can select from a variety of .wav files or record your
own.

Generate local page on remote intercom "+" keypress - When this is checked, pressing
and holding the Volume Up button on the Intercom generates a beep at the TalkMaster™
console.

Use beep tones at start and end of incoming calls - When this option is checked an beep is
inserted into the audio stream when the Intercom’s PTT button is pushed and released.

Hide when minimized - When this option is checked and TalkMaster™ is minimized,
TalkMaster™ can only be recalled by double clicking the TalkMaster™ ICON in the system
tray.

Talk button enabled by mouse click and hold - When this option is checked, the Talk button
can be activated by clicking and holding it with the mouse button or by pressing and holding
down the space bar. This overrides the default action of single clicking the Talk button or
tapping the space bar to activate the Talk button.

The Settings tab is used to make adjustments to individual Intercoms.
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Options | Setings i Advanced
=] Selected
1 Intercom
Metwork Audio Adjust Audio Yolume
Lesz delay  More buffer Softer 1 Louder
Friendly Mame [&liaz] |
Help | oK |

Selected Intercom - You can use the up and down arrows to select an Intercom from the list
of intercom connected to TalkMaster™.

Network Audio Adjust - This section is no longer functional.

Audio Volume - sets the audio volume on the selected Intercom. This can be overridden at
the Intercom by using the Volume Up and Volume Down buttons.

Friendly Name (Alias) - Displays the selected Intercom’s Name.

The Advanced tab is used to change options on individual Intercoms. It is retained for
compatibility with older intercoms as these options are now included in the Configure
Intercoms menu item. This will only affect Intercoms with an ICOM version beinging with
1.8 or earlier.

= Selected
| Intercom

bAocesz (D os:

GFIO 4 Mode
~
~

=

B

Help | oK |

Selected Intercom - You can use the up and down arrows to select an Intercom from the list
of intercom connected to TalkMaster™.

Access ID - Enter the administrator password to continue to make changes. The default value
is admin but this can be changed. Please see Configuration File Menu for more information.

Please refer to the Advanced Configuration section of the Intercom configuration tool for the
definition of these options.
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Audio Player

The Audio Message Player is automatically started when clicking on messages in the Calls
Waiting list. It allows messages that have arrived while communicating with another intercom
to be played back. Files will be automatically deleted after playback unless you uncheck the
Delete played files on exit option. Closing this dialog will select the corresponding intercom
in the Active Intercom List so you can begin a new call session.

Audio message player - i3 [X]
Mezzages from 071:24 PM, Jun 13
Intercom: EDW - Client

s
[#] n|m| o0:00:03

[v Delete played files on exit

By default, the clip will be deleted when you exit. However, if you had selected to Capture
Audio Archive, the clip will still be available via the Play Audio Archive option off of the File
menu.

Capture Audio Archive

This option will capture all audio data to the file system. It can be started from the menu option
File > Capture Audio Archive or by checking the box on the main display.

Audio Archive
[v Capture

Each time microphone or speaker output is produced, a separate file is created using the
following naming convention

XXX-YYYYYYYYYYYY-HHMMSS.wav where:
o XXX - IN for speaker audio, OUT for microphone audio

e YYYYYYYYYYYY - the twelve digit Ethernet MAC address of the intercom that was
communicated with.

¢ HHMMSS - Hours, minutes and seconds of the day in 24 hour format
¢ .wav - standard PCM wave file format.

The files are stored under the TalkMaster-ii3/iArchive directory. Each day an additional sub-
directory is created so all audio archives for a single day are stored in a single directory. The
directory name is formatted as YYYYMMDD.

The Play Audio Archive function can be used to easily find and play audio files for any date
and time.

Play Audio Archive

The Play Audio Archive function allows you to select and play a series of audio clips that have
been archived. It can be accessed from the menu option File > Play Audio Archive.
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# Archive Audio

June 2004 |Jl.|ne ﬂ |‘_Jnn4 -
Mon Tue Wed Thu Fri Sat Sun
1 2 3 4 4 E
7 o 9 10 11 12 13
14 15 16 17 18 9 20
1 22 23 24 25 26 27
28 29 a0
HRHBEEAEBREBEEEEBEEBEaEEBEEBEE
I
Frigndly Mame Clip Type  Intercom
Intercom [0 075713 Start Time  7:57:13
Tatal Time 000253 Clip Time 00:00:03
Time Left 000253
< Flay ‘ ‘ >

Use the drop down boxes to select the month and year and then click on the day. Any audio
streams which have been recorded are shown with vertical lines above the hour of the day.

The green lines represent the start of microphone audio and the red lines represent the start of
speaker audio. The blue bar indicates the current position for the Play button.

Click on a vertical bar and click Play. The audio will be played to the end of the audio clip you
selected. As the audio is played, the text underneath changes to indicate which intercom the
audio came from or was sent to.

If you want to skip backwards or forward between audio clips, use the << or >> keys.







TalkMaster Console Forwarding

Forward Intercoms

The Forward Intercoms function allows you to temporarily assign all of your intercoms to
another PC running TalkMaster™. This option can be accessed from menu option Console 2>

Forward Intercoms or from Tool Bar ICON

fs. Forward Intercoms to Alternate Con... E]

Location M arne | D | Court
Friendly Mame Mat Set 102300 0
EC" - Client 102730 o

R

| Forward | | 1921682543 :|3000

Once you forward the intercoms, the Forward Intercom window will stay open and the
Forward button will change to Return. The Pressing the Return button will send a message
to the alternate console indicating that the intercoms will be retrieved. If the alternate console
does not respond within 15 seconds, you will be asked if you want to retrieve the intercoms
anyway.

If you need to shut down the TalkMaster™ console while this dialog is open, the Intercoms will
stay forwarded to the Alternate Console. To return the Intercoms to this console, you will need
to use the menu option Console - Retrieve when you open up TalkMaster™ the next time.

Retrieve Intercoms

The Retrieve Intercoms function will retrieve Intercoms that have been forwarded with the
Forward Intercoms or that have been automatically forwarded via the Fail Forward function.
Only those Intercoms that have their default Server IP set to this TalkMaster™ console will be

returned to this console. This option can be accessed from menu option Console - Forward
=

=

Intercoms or from Tool Bar ICON =

Unattended Console

Setting the TalkMaster™ software to Unattended mode makes the console temporarily
unavailable. If the PTT button is pushed on an intercom, a message indicating that says "We
are unavailable to take your call at this time" will be sent. This message can be changed by
re-recording the unavailable.wav file in the iSupport subdirectory of the TalkMaster-ii3
directory.

The wav file must be recorded in either 8khz 8 bit PCM or 16 bit uLaw format.

15
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Console Currently Unattended

IIhattended Mode iz Enabled

Presz "Cancel' to return Console to normal
operation status.

16
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File Menu

YWiew Tools Console
v Capture Archive Audio
Play audio Archives

Exit

The File menu has three options:
Capture Audio Archives - toggles on and off the capture of mic and speaker audio.

Play Audio Archives - opens up a dialog that allows you to select audio archives by date and
time.

Exit - will end the TalkMaster™ server session.

View Menu

@ Tools  Console
Event log

Screen position ¥
Preferences

The View menu has three options:
Event Log - allows you to display the TalkMaster™ event log and save it as a text file.

Screen Position - has two options: Save current view saves the current window size and
Reset to default - sets it back to the size that the product originally shipped with.

Preferences - opens up the Preferences dialog.
Tools Menu

@ Console  Help
Mic and Speaker Levels

Coammon [P ports
Record program events 1o file

Configure Intercorms
Feset all Connections

i3 Intercom OS5 update

Mic and Speaker Levels - adjusts audio levels sent to and received from the intercoms. You
can also change the source used for the Talk button from the microphone to Internet/Line In
which allows you to play other sources of audio through the intercoms.

17
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. TalkMaster Audio Control
Advanced

Adjust Levels

i+ Microphone audio zent to intercoms
" Internet ar 'Line In' audio zet to intercoms
i Audio from intercoms [heard on this PC)

Microphone Lewvel to Intercoms

plo

[ Mute
i+ |lze Microphone oK
" Usze IntemetLine

Common IP Ports - is a list of commonly used port numbers. You may reference this if you
need to change the standard ports used by TalkMaster™ or the ii3 intercoms.

Record program events to file - should only be checked if directed by Digital Acoustics
Technical Support. Leaving this option checked for an extended period of time can cause
TalkMaster™ performance to be affected.

Configure Intercoms - brings up the Intercom Configuration Tool. This is used to setup the
intercoms with IP addresses, other configuration information and to load new firmware.

Reset All Connections - will cause TalkMaster™ to drop all current IP connections to active
intercoms and force them to reconnect to TalkMaster™.

ii3 Intercom OS update - is retained for compatibility with Intercoms that have OS version
beginning with 1.8 or earlier. It should only be used under the direction of Digital Acoustics
Technical Support.

Console Menu

@ Help
orward Intercoms

Fetrieve Intercoms

Unattended Console

Forward Intercoms - brings up a dialog box allowing you to temporarily forward all of the
active intercoms to another PC running TalkMaster™. Refer to Forward Intercoms for
complete instructions.

Retrieve Intercoms - will retrieve any intercoms from other PC’s running TalkMaster™ that
have this PC’s IP address assigned as their primary server to connect to. This can be used to
retrieve intercoms that have been forwarded to another console or have failed forward to
another console.

Unattended Console - allows you to temporarily suspend the consoles operation. Any
intercom that tries to contact the console is notified that no one is available to take their call. A
dialog pops up reminding you that this mode has been set. Clicking the Cancel button returns
the console to normal operation.

This setting is saved between TalkMaster™ sessions.




TalkMaster Menu Options

Help Menu

. EHelp on using TalkMasterd

Cnline Docurmentation

Digital Acoustics \Web Site
Check for new versions online
Abhout

Help on using TalkMaster - Opens up Help
Online Documentation - Directs you to online documents on the Digital Acoustics Web site
Digital Acoustics Website - Directs you to the Homepage for ii3 Intercoms

Check for new versions online - Runs an automatic software update check to see if you are
running the most current version of the TalkMaster™

About - Displays the current version information about TalkMaster™







Configuring Intercoms

Configure Intercoms

When Intercoms are shipped from Digital Acoustics, they do not have any IP address
information configured. To configure them, you must connect them to your network, install
TalkMaster™ and select the menu option Tools - Configure Intercoms. You will be asked
for a Password. Enter the default password of admin to continue.

TalkMaster™

Enter Adrinistrator pazsword to enter the Configuration utilib
then press OF.

Aoccess 1D |

The Intercom Configuration Tool will immediately search for all Digital Acoustics intercoms
connected to your current network segment. You can then configure their IP address
information and the IP address of the server they will connect to.

If you have intercoms located in a different network segment, you may not find
them since many routers filter out UDP Broadcasts. You can either install
these intercoms on the current network segment or you can install a copy of
TalkMaster™ in the other network segment to configure your intercoms.

To configure Intercoms to connect to TalkMaster™, see Intercom Configuration - TalkMaster
Clients.

To configure two Intercoms to communicate with each other in Direct Mode, see Intercom
Configuration - Direct Mode.

PLEASE CHANGE THE DEFAULT PASSWORD:

Before leaving the Intercom Configuration Tool, change the default password by selecting the
menu option File > Set Administrator Password. Make sure to record your new password
in a secure place or you will not be able to access the Intercom Configuration Tool.

Advanced Configuration

When the Advanced Configuration option is checked in the Intercom Configuration Tool View
Menu, you can specify addition options for an ii3 Intercom.

If these options are grayed out, you have an intercom with older firmware. You can configure
these options from the main TalkMaster™ screen using the menu option View - Preferences
and selecting the Advanced tab. To update the firmware, see Updating Firmware.

21




Configuring Intercoms

Advanced Settings
GPID 4 Mode

Fail Forward IP 1 0ooo lIl ' Factory Default [ Remote Listen Disable

Fail Forward IP 2 0000 [0 ]| Door/Relay Output O

Fefl Fereml [F 3 0.0.00 lII " Listen tumng on GPIO 4 [ Mo Beep Tone After PTT Released
" Logic Input Door Relay Activate |:|

Fail Forward IP 1,2,3 allow you to specify up to three IP addresses of alternate TalkMaster™
consoles that this Intercom will attempt to connect to if it's current TalkMaster™ console
becomes unavailable. If an Intercom has failed forward to an alternate IP and it's default
TalkMaster™ console is restarted, the default TalkMaster™ console can reacquire the
intercom by using the menu option Console = Retrieve Intercoms.

GPIO 4 Mode allows you to specify how General Purpose 1/0 (GPIO) port 4 is used.

o Factory Default - on EDW/EDB units, the Factory Default is set to use the Monitor button
for GPIO 4. On all other units, GPIO 4 is available.

e Door / Relay Output - on ii3 Intercom models that include a relay for opening a door or
gate, the Door/Gate button will become visible in the Active Intercom List. This option is
used in conjunction with Door Relay Activate (see below) which sets the amount of time the
relay will stay active

o Listen turns on GPIO 4 - used with custom developed applications. This option turns on
GPIO 4 when ever the Intercom is in Listen mode.

¢ Logic Input - used with custom developed applications to monitor other equipment.

Remote Listen Disable - disables the ability of TalkMaster™ to have it's Listen button turn on
the PTT button on the Intercom. With this option set, the Intercom Operator must press the
PTT button on the Intercom for the TalkMaster™ operator to hear audio from the intercom.

Default to Listen (Direct Mode) - is only available if option Set as Server-Peer is enabled.
Enables the Server intercom in Direct Mode to automatically start-up listening to the other
Intercom.

No Beep Tone After PTT Released - turns off the soft beep that is played on the intercom
after the PTT button is released

Door Relay Activate - on ii3 Intercom models that include a relay for opening a door or gate,
this option sets the number of seconds that the intercom’s relay will stay active when the
Door/Gate button is pressed in the Active Intercom List. This is used in conjunction with GPIO
4 - Door / Relay Output

Intercom Configuration - TalkMaster Clients

Configuring intercoms for use with TalkMaster (Point to MultiPoint)

This procedure configures Intercoms to connect to the Server IP address of the PC running
TalkMaster™.

To configure two intercoms to connect to each other, please see Intercom
Configuration - Direct Mode.

From the main TalkMaster™ screen, select the menu option Tools = Configure Intercoms
and enter your password to proceed. The system will scan the local network segment using a
UDP Broadcast to find all ii3 Intercoms. New Intercoms will show up with IP addresses of
zero.

22




Configuring Intercoms

Selected Intercom Setting

VLDCEIUDH B3 1';22;? Ellzﬁdudress %?;Tli”:ddr f+ Setas Client " Set &z Server-Peer
W 102774 0.0.00 Mo 1P addr [ Assian IP automatically with DHCP
P fddress
Subnet Mask
Part lIl
Location Mame

[ Assian this PC address as client's server
Server [P 0.0.00 :| 3000

This PC is: MPCO03
‘Pl |F‘ort‘ 3000 | § Exit | Cancel| Apply |

Search

If you have intercoms located in a different network segment, you may not find
them since many routers filter out UDP Broadcasts. You can either configure
these intercoms on the current network segment prior to installing them on the
desired network or you can install a copy of TalkMaster™ in the other network
segment to configure your intercoms.

Selected Intercom Setting
%ﬁ“ Set az Client " Set as Server-Peer

[ Aszsign IP automatically with DHCP

IF Address | 0.0.0.0 |
Subnet Mask | 0.0.0.0 |
G ateway | no0o0o0 |

Location Mame | <enter a name heres: |

[ 2s=sign thiz PC address az client's server

Server P | 0000 o] 3000 |

E wit | Eancel| Apply |

For each intercom that you want to configure, click on it and then set the options as follows:

o Set as Client - Click this option

o Assign IP automatically with DHCP - This option determines how the Intercom’s IP
address is assigned. The Intercom IP address information can be assigned as a Static IP

address or can be dynamically assigned if your network has a DHCP server. To use DHCP,
check the box Assign IP automatically with DHCP.

Your system MUST have DHCP assignment capability if you choose to use this option. If
you are unsure do NOT use DHCP.

To assign a Static IP address, uncheck the box Assign IP automatically with DHCP and fill
in the IP Address, Subnet Mask and Gateway. You do not have to fill out the Port.

o Location Name - Set an easily recognizable text name to reference a specific Intercom.
This name will identify the Intercom in the main TalkMaster™ screen.
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Configuring Intercoms

¢ Assign this PC address as client’s server - This option determines the TalkMaster™ |P

address that the Intercom will connect to. To assign this PC as the TalkMaster™ console for

this intercom, check Assign this PC address as the client’s server. To specify a different
TalkMaster™ console, uncheck the box and fill in the IP address and the default Port
number of 3000.

o Apply - This option will save your settings to the selected intercom. After applying changes
to an intercom, the unit will be reset and will be unavailable for 10-15 seconds

e Cancel - This option cancels changes that have not been Applied

Exit - This option closes the Intercom Configuration Tool screen and returns to the main
screen after you have completed configuring all intercoms.

This PC is: XXXXXXXX - This option allows you to change the default Port number used by
TalkMaster™. If you change this setting, it will be reflected in the Assign this PC address as
client’s server for you.

T[:{.f PC is: MPCO03

1P| | Port| 3000 |

Search - will re-search for all Digital Acoustics’ ii3 Intercoms so you can verify all of your
changes. Please note, that if you Apply changes to an intercom, the unit will be unavailable
for 10 -15 seconds. If an intercom does not appear in the list, try searching a second time.

5D

Search

If you need to change other options on the intercoms, make sure that you check menu option
View > Advanced. Refer to Advanced Configuration for details.

Intercom Configuration - Direct Mode

Configuring two intercoms in Client-Server mode (Direct Mode - No PC required)

This procedure configures two Intercoms to connect to each other. This connection can be on
a LAN or across the Internet on a WAN.

To configure intercoms to connect to TalkMaster™, please see Intercom
Configuration - TalkMaster Clients.

From the main TalkMaster™ screen, select the menu option Tools - Configure Intercoms
and enter your password to proceed. The system will scan the local network segment using a
UDP Broadcast to find all ii3 Intercoms. New Intercoms will show up with IP addresses of
zero.
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Selected Intercom Setting

VLDCEIUDH B3 1';22;? Ellzﬁdudress %?;Tli”:ddr f+ Setas Client " Set &z Server-Peer
W 102774 0.0.00 Mo 1P addr [ Assian IP automatically with DHCP
P fddress
Subnet Mask
Part lIl
Location Mame

[ Assian this PC address as client's server
Server [P 0.0.00 :| 3000

This PC is: MPCO03
‘Pl |F‘ort‘ 3000 | @ Exit | Cancel| Apply |

Search

If you have intercoms located in a different network segment, you may not find
them since many routers filter out UDP Broadcasts. You can either configure
these intercoms on the current network segment prior to installing them on the
desired network or you can install a copy of TalkMaster™ in the other network
segment to configure your intercoms.

Determine which of the two intercoms will be the Server-Peer and which will be the Client.
The Server-Peer can:

e Turn on EDW/EDB Monitor/Open mode which keeps the client’s PTT button on. The
Server-Peer can talk to the client by pressing it's PTT button. The client operates in a fully
"hands free" mode

¢ Send a signal to an EW2W Client Intercom to open a door by pressing and holding the
EDW/EDB Monitor/Open button until a dual tone beep is heard. The relay will remain active
for the number of seconds specified in the Door Relay Activate option under Advanced
Configuration.

To set up the Server-Peer:

Selected Intercom Setting

" Set as Client f* Set az Server-FPeer

O
IP Address | |
Subnet Mask. | 0.0.0.0 |
G ateway | 0.0.0.0 |

Location Mame | |

O
Server IP | 192.168.1.100 |:| 3000 |

Exit | I:ance|| Apply |

o Set as Server-Peer - Click this option

o Assign IP automatically with DHCP - This option is automatically grayed out
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o Location Name - This option is automatically grayed out

¢ Assign this PC address as client’s server - Uncheck Assign this PC address as the
client’s server and enter the IP address of the Server-Peer and the Port number. You can
change the default Port of 3000 as long as you specify the same port in the Client.

o Apply - This option will save your settings to the selected intercom. After applying changes
to an intercom, the unit will be reset and will be unavailable for 10-15 seconds

To set up the Client:

Selected Intercom Setting
f* Set az Client i~ Set az Server-Peer

[ Assign IP automatically with DHCP

IP Address | 192168150 |
SubnetMask | 25952552550 |
Gateway | 192.168.1.1 |

Location Mame | <enter a name heres: |

[ &s=zign thiz PC address az client's server

Server P | 192.168.1.100 |: 3000 |

E wit | Eanu:el| Apply |

¢ Set as Client - Click this option

¢ Assign IP automatically with DHCP - The Intercom IP address information can be
assigned as a Static IP address or can be dynamically assigned if your network has a DHCP
server. To use DHCP, check the box Assign IP automatically with DHCP. Your system
MUST have DHCP assignment capability if you choose to use this option. If you are unsure
do NOT use DHCP. To assign an IP address, uncheck the box Assign IP automatically
with DHCP and fill in the IP Address, Subnet Mask and Gateway. You do not have to fill
out the Port.

e Location Name - Not used in Direct Mode
¢ Assign this PC address as client’s server - This is automatically unchecked so you can
enter the IP address of the Server-Peer and its Port number. The Port number must match

the Port number specified in the Server-Peer setup.

o Apply - This option will save your settings to the selected intercom. After applying changes
to an intercom, the unit will be reset and will be unavailable for 10-15 seconds

Search - You can re-search for Intercoms to verify all of your changes. Please note, that if you
Apply changes to an intercom, the unit will be unavailable for 10 -15 seconds. If an Intercom
does not appear in the list, try searching a second time.
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5D

Search

The configured intercoms will look something like this:

Location Mame lcam 1D | P Address Details

& Front Door
$Elack Coor 10277A  1892168.1.50 Client

If you need to change other options on the intercoms, make sure that you check menu option
View > Advanced. Refer to Advanced Configuration for details.

Exit - This option closes the Intercom Configuration Tool screen

The Server-Peer will play a short beep and the Active and Link lights will turn solid on both
intercoms indicating that they have made a connection.

Updating Firmware

Updating firmware should only be done under the direction of Digital Acoustics
Technical Support. Improperly flashing Intercoms can render the units
inoperable.

Intercoms must have minimum firmware levels of 1.9.5.66.1-xx.x-3.68.4 to use the following
features:

Console Forwarding

UDP Broadcast

Fail Forward IP addresses

Door Relay Activation time

Location Name Stored in Intercom

Intercoms shipped with this version of TalkMaster™ 1.5 already include the most current
firmware. To verify the firmware level, right click on an intercom in the main TalkMaster™
screen and view the OS version. In the following example, v1.9.5.66.8 is the ICOM version
and 3.68.4 is the NIC version.
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Send announcement to selected units
activity and Connection Details »

Feset connection
Intercom ID# 1026E9
05 version: ¥1,9.5,66,8-0.0-3.68.4
If you would like to update firmware in your intercoms, please contact Digital Acoustics

Technical Support to verify upgradeability and to obtain the current firmware. Please have the
Intercom ID# and OS Version available for each intercom that you would like to upgrade.

In order to update NIC Firmware, see NIC Firmware Updating
In order to update ICOM Firmware, see ICOM Firmware Updating

NIC Firmware Updating

If you are going to perform a NIC firmware update, please confer with Digital
Acoustics Technical Support to verify upgradeability and to obtain the current
firmware. Please have the serial number and OS Version available for each intercom that
you would like to upgrade.

In order to update the NIC firmware, you must configure the Intercom to connect to the copy of
TalkMaster™ that you will be doing the update from. Please refer to Intercom Configuration -
TalkMaster Clients.

It is strongly recommended that the update be done on a local area connection (LAN) instead
of on a wide area connection (WAN) due to the critical nature of firmware updating.

Use the Tools - Configure Intercoms menu option to open the Intercom Configuration Tool.
You will need to supply your password to access this screen.

Click on the Intercom you wish to update and select Action = NIC Firmware Upload.

Confirmation for memory upgrade |E|

.."_'., Update NIC operating system now?

Selected intercom ID: [#102814]
with revision code dated Jun 15 2004,

Yes Mo

TalkMaster™ will connect to the Intercom and begin uploading the firmware. When the upload
is completed, a dialog box will be presented informing you that the action was successful.
Once you click OK, the screen will lock for 30 seconds while the firmware re-programming
takes place.

DO NOT TURN THE INTERCOM OFF WHILE THE FIRMWARE RE-PROGRAMMING
TAKES PLACE!
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ICOM Firmware Updating

If you are going to perform an ICOM firmware update, please confer with
Digital Acoustics Technical Support to verify upgradeability and to obtain the
current firmware. Please have the serial number and OS Version available for each
intercom that you would like to upgrade.

In order to update the ICOM firmware, you must configure the Intercom to connect to the copy
of TalkMaster™ that you will be doing the update from. Please refer to Intercom Configuration
- TalkMaster Clients.

It is strongly recommended that the update be done on a local area connection (LAN) instead
of on a wide area connection (WAN) due to the critical nature of firmware updating.

Use the Tools = Configure Intercoms menu option to open the Intercom Configuration Tool.
You will need to supply your password to access this screen.

Click on the Intercom you wish to update and select Action > ICOM Firmware Upload.

Confirmation for memory upgrade ||

.'T Update i3 flash operating system now?
L

Selected intercom ID: [#102814]

with revision code dated Jun 12 2004,

Yes Mo

TalkMaster™ will connect to the Intercom and begin uploading the firmware. When the upload
is completed, a dialog box will be presented informing you that the action was successful.
Once you click OK.

DO NOT TURN THE INTERCOM OFF WHILE THE FIRMWARE IS UPLOADING!
Troubleshooting

TalkMaster requires properly configured ii3-series intercoms installed on the network to
operate correctly. Please check the following before contacting support:

o Verify power connections. The "Active" LED on should be on or flashing

o If you cannot detect ii3 units when you SCAN, verify that the LINK LED is on and TalkMaster
is running on the SAME network segment

¢ Refer to the LED Indicator section in your hardware manual and review the diagnostic
information presented there

¢ ii3 Intercoms may operate across some firewalls or VPNs if your administrator has
configured the appropriate ports and IP addresses. Most likely, you will not be able to
configure the Intercoms across the firewalls or VPN’s since UPD traffic is blocked by most
routers

¢ If you have multiple network cards in this PC, verify that intercoms are connected to the card

that TalkMaster has recognized. You can verify the IP address that TalkMaster is using by
looking in the Intercom Configuration Tool under "This PC is: XXXXXXXX":
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T[:{.f FC is: MPCO03
1P| | Port| 3000 |

¢ If you hear the intercom beep once every minute or so, the intercoms may not be able to find
a DHCP server. Try re-scanning within 10 seconds after the beep to override the intercom’s
DHCP request.

¢ If you cannot detect any intercoms using the Intercom Configuration Utility, connect the PC
directly to the ii3 intercom using a crossover cable. Then try to Search for the Intercom

again.

o Refer to your TalkMaster ii3-m or ED series manual for additional diagnostic techniques and
troubleshooting tools
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Intercom Configuration Tool Menu Options

Configuration File Menu
Yiew Action Help

Set Administrator Password

Exit

Set Administrator Password - allows you to change the default password of admin used to
access the Intercom Configuration Tool.

Exit - exits the Intercom Configuration Tool

Configuration View Menu

W Action  Help
1 ommon Port Assignments

: v Acvanced

Common Port Assignments - is a reference list of the common IP port settings

Advanced - makes the Advanced Settings section of the Intercom Configuration Tool
available. Please see Advanced Configuration for details. This setting is remembered
between TalkMaster™ sessions.

Configuration Action Menu

earch Boards

Apply settings

MIC Firmweare Upload
ICOM Firmware Upload

Search Boards - will search the current network segment for ii3 intercoms
Apply Settings - saves changes to made to the current intercom

NIC Firmware Upload - updates a portion of the ii3 intercom firmware
ICOM Firmware Upload - updates a portion of the ii3 intercom firmware

Configuration Help Menu

Eelp with Configuration Tool

Test DHCP connections |

Digital Acoustics Home Page ;

Help with Configuration Tool opens the Help window

Test DHCP connections - determines whether there is a DHCP server available on your
network




Intercom Configuration Tool Menu Options

Digital Acoustics Home Page - opens the default web browser to the ii3 intercom home page
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Access ID

Active Intercom List
Advanced Configuration
Advanced Settings
Assign IP

Audio Archive

Audio Player

Audio Volume

Auto Response
Automatic Mode

B

Beep Tone After PTT Released

C

Calls Waiting list
Capture Audio Archive
Client

Client-Server
Common IP Ports
Configure Intercoms
Console Forwarding

D
DHCP

Digital Acoustics Technical Support

Digital Acoustics Web site
Direct Mode
Door/Gate button

E

Escape key
Ethernet MAC
Event Log

F

Fail Forward IP
Firmware

Flashing

Forward Intercoms

G
Gateway
GPIO
Group
Grp

IndeXx
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ICOM Firmware Upload
Intercom Configuration
Internet

IP Address

L

LAN

Listen button
Listen Mode
Location Name
Logic Input

M

Manual Mode
Mic

Monitor
MultiPoint

N

New Intercoms
NIC Firmware Updating

(0]

Online Documentation
Options
OS Version

P

Password

Play Audio Archive
Port

Preferences

R

Relay Output

Release Notes
Remote Listen Disable
Re-recording

Reset All Connections
Retrieve Intercoms

S

Screen Position
Search Boards
Selected Intercom
Server IP
Server-Peer

Set Administrator Password
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